User Manual of Wondershare Video Editor (Windows V4.8+)

Jen. 7, 2015
01. Introduction

Thanks for your interest in Wondershare Video Editor - the easy-to-use and trendy video editing software that lets you produce cool videos, regardless of your skill level. Magic Wondershare Video Editor gives you a helping hand to get started with any new movie project by importing and editing your video, adding special effects and transitions and sharing your final production on a DVD, mobile device or the web.

- **Wondershare Video Editor at a Glance**

Wondershare Video Editor comes with 2 different video editing modes – Easy Mode and Full Feature Mode to meet your video editing needs.

Easy Mode lets you easily create your own movie by providing various built-in templates. Simply import your own media and you’re done!

Full Feature Mode comes with all the fully-customizable timeline editing features to arrange scenes, edit clips, and add vivid polish to your movie.

After launching Video Editor, choose a mode to get started. Please make sure you select the right aspect ratio for your video display (4:3 or 16:9) when you start your project.
• **Easy Mode**

If you choose to start your video project with Easy Mode, follow the steps below to create your own video:
• How to use Easy Mode?

1. Choose a template or download more
2. Add your media files
3. Preview the result
4. Export your creation or turn to Advanced Mode
5. You have completed the steps.
• Full Feature Mode

If you choose Full Feature Mode, the interface shown below appears as your default workspace. This workspace is the heart of the Full Feature Mode, where you can import, arrange, edit and add effects to your media files. The rest of the guide mainly focuses on how to use Full Feature Mode.
To get started, please click the "File" button and drag files to Timeline.
• Interface Introduction about Full Feature Mode

1. **Media Library**: The Library is the source for all your media, including video clips, photos, and music. It also houses transitions, effects, and a variety of other media assets that you can use in your projects.

2. **Toolbar**: The toolbar provides easy access to many editing commands. You can change your project view, zoom in and out on the Timeline, and launch different tools that can help you edit efficiently.

3. **Timeline/Storyboard**: The Timeline or Storyboard is where you assemble the media clips for your video project. You can click to switch between the Timeline and Storyboard view.

4. **Preview Window**: The Preview Window shows the current video being played on the Timeline or Storyboard.
02. Get Started

• Now follow the steps below to install and register this software:

• **Download**
  • If you haven’t downloaded the software, download here: [http://www.wondershare.com/video-editor/](http://www.wondershare.com/video-editor/)

• **Install**
  • 1. Double-click the .exe file that you downloaded.
  • 2. Follow the instructions on your screen to finish the installing process.

• **Register**
  1. The non-activated version of the program has no function limitations, although the watermark banner will be placed in the center of the output video file.
  2. To remove the watermark, you need to purchase the software to get the registration code. If you haven't got your registration code, retrieve it here.
  3. After getting the registration code, start the software.
  4. On Easy Mode, click Help icon, in the context menu, click Register button.
5. Or in Full Feature Mode, click the Register button on the top right corner of the program.

6. In the pop up window, copy and paste your registration info to it and click Register button to finish registration.
• **Update**
  1. Updates provide important new information about your application. You can check for and install product updates.
  2. In Easy Mode, click > Check for update.
  3. In Full Feature Mode, click > Check for update.

• **Uninstall**
  1. Open the Windows Control Panel.
  2. In the Programs category, click the Uninstall a program link.
  3. In the Programs and Features window, click Wondershare Video Editor in the list of applications.
  4. Click Uninstall/Change.
  5. Follow the instructions on your screen.
03. Create Projects

Saving project is a necessity when working with Wondershare Video Editor. It’s helpful if you want to interrupt your work and resume it later or modify the saved project to format a new creation very quickly. The steps below will explain some project basics.

• **Build new projects**

When you choose to use Full Feature Mode, the program automatically opens a new project and lets you start creating your movie. You can also start from an existing project.
• **To create a new project**
  • Click Video Editor > New and choose 4:3 or 16:9 aspect ratio [Ctrl + N].

• **To open an existing project**
  • Click Video Editor > Open [Ctrl + O].
• **Preview the project or clip**

While creating your movie, you will want to preview your work frequently to see how your project is progressing. You may choose to play the entire project or only a part of the project to preview changes.

**To preview the entire project or clip**
Choose the entire project or clip and click Play.

**To preview part of the project or clip**
Use the Slider to select the start point of the project or clip and click Play.
• **Undo and redo actions**

You can undo or redo the last action that you performed while working on your movie.

• **To undo the last action**
Click the Undo button on the Toolbar or use the keyboard shortcuts [Ctrl + Z].

• **To redo the last undone action**
Click the Redo button on the Toolbar or use the keyboard shortcuts [Ctrl + Y].
• **Save projects**
  
  • You can save projects so that you can edit or complete them later.
  
  • **To save your project**
  
  • Click [Video Editor] > Save Project [Ctrl + S] or click the Save Project button.
  
  • Note: Wondershare Video Editor project files are saved in *.wve file format.
  
  • Tip: You can click Video Editor and select Settings to specify options for the program, such as default snapshots folder, update frequency, messages and more.
04. Import and Organize Media

When a project is built, you can now import your media files to the program. Wondershare Video Editor enables you to import video shot by any type of digital camera, camcorder, mobile device, etc.—and with all major standard and HD video formats. Or, if you want, record video directly from your computer’s webcam. A Media Library is also provided for you to organize your media clips so you can easily and quickly access assets for your projects.

• Import your media files

There are three ways to add media clips to the library:
1. Click the Import button and then choose the target clips.
2. Click Video Editor > Add Files.
3. Directly drag and drop the media files to the Media Library.
• **Record a video file**

You can also record a video file using the built-in video recording function. To use this function, you should first make sure the capturing device is connected properly. Then follow the steps below:

1. Click the Record button ![Record](image) on Media library.
2. In the pop up Capture Video window, click Record to start recording and click it again to stop recording. Then click OK to save the recorded video file.
The recorded video file will be saved into Media Library automatically and you can drag it onto Timeline for use.
• **Use the Media Library**

When all the media files have been imported to the program, you can make use of the Media Library to organize them.

• **To select media in the Media Library**

Select one media file: click a thumbnail.
Select multiple media files: press and hold [Ctrl], and then click the thumbnails you want.
Select a sequence of media files: click the first thumbnail in the sequence, press and hold [Shift], and then click the last thumbnail in the sequence.

• **To delete media clips from the Media Library**

In the Library, right click the clip and click Delete.

Note: All the clips actually remain in their original location since they are just referenced in the Media Library. So if you delete a clip from the library, only the reference is deleted. You can still find the actual file in the location where it is stored.
• To sort clips in the Media Library by name, duration or type
  Click the Sort button 🔄, then select Name, Duration or Type.
• To access sample colors or video
  Wondershare Video Editor also provides several sample colors or video. To get access these resources, just click “User’s Album” and choose “Sample Colors” or “Sample Video”.

![User’s Album]

- User’s Album
- User’s Album
- Sample Colors
- Sample Video
05. Basic Editing

After all the media files have been imported, you can now edit them for your video project. You can arrange clips in the order you want them to appear in your movie, and “clean up” your video footage, editing out the parts you don’t like and keeping only the best footage to include in your movie and more.

• Add clips to the Timeline

Before editing, the clips should be added to the Timeline. There are two ways to do that:

1. Choose a clip in the Media Library and drag it to the Video Track.
2. Right click a clip in the Media Library and select “Add Clip”.

Note: Don't drag and drop a file to the existing media on Timeline unless you want to split it.

Tip: For easier access to the different media clips on the Timeline, drag the slide bar to adjust the view size of the Timeline.
• You can also click the Zoom to Fit Timeline button to automatically zoom the view size.

• **Split a clip**

  • The split function helps you break a scene into two separate clips. You can delete the part you don’t want or save it to use elsewhere in your movie.
  
  • Wondershare Video Editor provides two ways to help you split a clip: directly split on the Timeline or use the scene detection feature to detect different scenes in a video file and automatically break it down into several clip files.
• **To split a clip directly on the Timeline**
  1. Select a clip in the Timeline Viewer.
  2. Drag the Split Maker on either side of the clip to change the length. The Preview Window reflects the position of the Trim marker in the clip.
  3. Click the Split button or right click and choose the "Split" option from the context menu.
  4. If you want to delete the unwanted segment, right click and choose "Delete".

• **To automatically split a clip using scene detection**
  1. Right click the target video file in the Media Library and select “Scene Detection” option. This will open the Scene Detection dialog box.
2. Click “Detect” and after several seconds, the file will automatically be broken down into several clip files according to the content change.

3. Then click “Apply” and the separated clips will appear on the Timeline.
**Crop a clip**

1. The crop function preserves the selected part of a clip and deletes the unnecessary elements. Your video will look much better if you crop black bars from the sides or remove background that doesn't contribute anything to the finished product. To crop a clip:

2. Select a clip in the Timeline Viewer or Storyboard Viewer.

3. Right click the clip and choose the "Crop" option or double click the clip and click the Crop option.

4. In the pop up window, stretch and move the rectangle in the Preview Window to define the desired frame area. You can also choose from "16:9" or "4:3" to crop the video automatically.
• **Rotate or flip a clip**

1. If you record video on a phone or a compact camera in the wrong way, the rotate or flip function can help fix that. To rotate or flip a clip:

2. Double click the clip in the Timeline or storyboard viewer.

3. In the Editing pane, click the four buttons on the top to rotate or flip your clip and check the result in the Preview window.

4. Then click the Return button and the clip will be rotated in the chosen way.
• **Join videos**
If you have shot or downloaded several videos in a sequence, the join function can have you put them together in no time. To join videos together, just place all the videos on the Timeline in the order and click "Export".

• **Enhance a clip**
Wondershare Video Editor provides two ways to help you improve the appearance of a video or image clip by adjusting its current properties.
  • **To manually enhance a clip**
Double click the video or image clip to enhance on the Timeline. Then drag the sliders to adjust the Contrast, Saturation, Brightness or Hue of the clip. You can watch the Preview Window to see how the new settings affect the image.
  • **To automatically enhance a clip**
You can also check the Enhance box to activate the Auto Denoise and Auto Video Enhancement to the selected object.
Note: Click the Reset button to reset the original color setting of the clip.
• Modify video playback speed

Double click the video clip on the Timeline. Drag the slider to adjust the playback speed of the video clip.
• **Change image duration**

Once an image is added onto the Timeline, it has default duration of 5 seconds. But you may want to the image to play for a longer or shorter duration. There are two ways to change the duration of the image.

1. Directly drag and drop the edge of the image on the timeline to change the duration.

2. Double click the image and enter the Duration time in the box. You can click “Apple to all” to apply the same duration time to all the images in the project.
Apply Motion effect

1. Motion effect can help you turn any still photo to animated one.
2. To add this effect, double click the image on the Timeline and then switch to Motion tab. Here you can double click on any motion to apply it on the image.
3. To remove the added motion, right click the thumbnail on the Timeline and select "Delete Motion" from the menu.
• **Take a snapshot from a video clip**

To take a photo snapshot of a video clip and save it as an image file, play the video file and pause the video where you want to take the snapshot. Then click the Snapshot icon 📸 take snapshot. The image snapshot will automatically be added to the Media Library and saved to your working folder.
06. Advanced Editing

Besides the basic editing functions such as Rotate, Crop, Split and Cut, Wondershare Video Editor also provides you with more advanced functions like Tilt-shift, Mosaic, Face Off, Jump Cut at Beats (which are included in the Power Tool) and Flash and Hold.

• **Power Tool**

Power Tool includes four powerful editing effects: Tilt-shift, Mosaic, Face Off and Jump Cut at Beats. These tools will help you add professional touch to your videos.

• **To access the Power Tool**

Choose the clip on the Timeline and click the Power Tool button above the Timeline or right click the clip and choose “Power Tool” option. A window will appear allowing you to apply any of these four effects.

• **To apply Tilt-shift effect**

Click Tilt-shift and tick “Apply Tilt-Shift to the clip” check box, and then a focal area appears in the image. You can adjust the size of the focal area by dragging the yellow line or adjust the tilt direction by controlling the white circle between the two yellow lines. When all the adjustments finished, just click “OK” button.
• **To apply Mosaic effect**

Click Mosaic and check “Apply Mosaic to the clip”, and then click on “Add” button. Now a mosaic area appears on the clip. You can move it to the desire position and drag the yellow frame to adjust the size. Or drag the Percent slider bar to get the effect you want. When finished, just click “OK” to save your editing.
• To apply Face Off effect

Click Face Off and tick “Apply Face Off to the clip” check box. Then choose a funny face you like and it will be immediately put on the face the program detected. You can preview the video by hitting on the Play button, then click “OK” to save the editing.
• **To apply Jump Cut at Beats effect**
  
  • Click Jump Cut at Beats and tick “Apply Jump Cut at Beats to the clip” check box. Then drag the Jump time length and Play duration sliders to customize the effect. Preview the video by clicking the Play button, then click “OK” to save the editing.
• Flash and Hold (Close-up)

Flash and Hold effect will add a brief flash transition to the selected clip and its last frame. The last frame is then turned into a still image that remains onscreen for 4 seconds, but you can change this duration if you want.

To apply a close-up to your video, simply choose the clip on the Timeline and click the Flash and Hold button above the Timeline or right click the target clip and choose “Flash and Hold” option. This will automatically add a Flash and Hold segment at the beginning of the clip. Click and drag the new section to place elsewhere.
07. Work with Audio

Sound is one of the elements that determine the success of your video production. Wondershare Video Editor allows you to add music, voiceover, and sound effects to your project. It also allows you to do some editing on the audio track.

• **Add audio files**

You can insert background music on the Music Track, sound effects on the Sound Track or even record and add your own voiceover narration.

• **To add background music**

Click the Import button to browse for audio files in your computer or directly drag and drop the audio files to Media Library. Then place them on the Music Track.
• **To add voiceover narration**

1. On the toolbar above Timeline, click Record 🎤 to bring up the Record Audio dialog. Hit Start and you will have 3 seconds of countdown to start speaking. When finished, click Stop. Then the voiceover clip will appear on the Timeline.

2. To start a new record on the Timeline, no need to close the dialog, just move the Time Indicator to another position and hit Start again.

3. Tip: It’s recommended to do the recording in about 10-second sessions, so that it’s easier to remove a badly recorded narration and redo it. To remove, just right click the clip on the Timeline and choose “Delete”.
• **Split audio clips**
  
  • Use the Split Maker to indicate where you want to split the audio clip. Then right click the clip and select “Split” or click the Split button above on the toolbar.
• Adjust audio settings

• Wondershare Video Editor also enables you to adjust the default audio settings. Double click the audio file on the Timeline, and then you can adjust Speed, Volume and Pitch settings or add Fade in/out effect. Simply use the slider to tune your audio up. You can immediately hear the result. If you are not satisfied, click Reset to start from scratch.
• **Mute audio**

To mute the video clip which contains audio track, just right click the video and choose "Mute" from the content menu.

• **Detach audio from video**

To detach audio from video, simply right-click the video and choose “Audio Detach” —the detached audio track will automatically appear on the Audio Track.
08. Insert Transitions

- Transitions can help your video move smoothly from one scene to the next. They can either be applied to single clips or in between all clips on the timeline. Effective use of this feature can add a professional touch to your creation.
• **Add a transition**
  • Hit the transition icon above the Timeline. Select from different categories of transitions. Then do one of the following to add a transition:
  • 1. Choose and drag an effect between two clips on the Timeline. Drop your effect and it will snap into place.
  • 2. Move the slider between two clips. Right click an effect and choose “Apply”.
  • You can only drag and drop one transition at a time. To replace a transition in your project, drag the new transition onto the timeline or right click it and choose “Apply” for replacement.
  • **To add a selected transition to all video track clips**
  • Right click the thumbnail of the selected transition and choose “Apply to All”. 
• **To add random transitions to all video track clips**
  Right click the thumbnail of any transition and choose “Random to All”.

• **To customize a preset transition**
  Double-click a transition effect in the Timeline. Change the value for the number of seconds you want transition to take place in between clips. Click “Apply to All” if you want all the transitions have the same duration time.
• **Save and delete transitions**
  
  You can select your favorite transitions and save them in the “Favorite” folder, so that you can quickly find them later. You can also delete transitions that you do not use from the project.

• **Save a transition in “Favorite” Folder**
  
  Select the thumbnail of the transition. Right click it and choose “Add to Favorites” to add the transition in Favorite Library list.

• **Delete a transition from a project**
  
  Right click the transition on the timeline and select “Delete”. 
09. Use Texts and Intro/Credit

Wondershare Video Editor lets you easily and quickly create beautiful-looking titles, complete with special effects. You can add captions as well as Intro and credit.

• **Add text**

There are various texts presets in the Text Library for you to add animated titles. You can also save custom presets.

To add a preset text to your project

Go to the Text Library. Drag and drop the preset text onto the Timeline. Or right click it and choose “Apply”.
• **To save your text to Favorite**
Right click a title clip in the Library and click “Add to Favorites”. You can access later in the Library by choosing Favorites category.

• **To delete text**
Right click the clip on the Text Track and choose “Delete”.

• **Personalize Text and Add Animation**
You can format your text by changing the font, color, or placing it to a new position. Superimpose your text on a solid or gradient shape to make it stand out. You can also define how long a title clip appears by adjusting the title clip duration.

• **To enter text**
Double click the clip on the Text Track and enter the text in the blank area. Then modify the properties of the title clip by using the different options such as font size, color and more.
Wondershare Video Editor
• **To apply preset**
  Go to the Preset tab and click a thumbnail to apply the effect.

• **To customize text**
  The Customize tab contains four options: Fill, Border, Shadow and Background.
  Fill: You can tick the Fill option and you can choose from “Color Fill”, “Image Fill” and “Gradient".
  “Color Fill”: Pick the color swatch to set the background color.
  “Image Fill”: Choose from the built-in images or click image fill to load your own image.
  “Gradient Fill”: Set the start and end color and click an arrow button to set the direction.
Tip: You can drag the slide below to set the Blur and Opacity value.
• Border/Shadow/Background: Choose the respective options and change the attributes using the dialog box.

• **To apply animation**
  • Go to the Animation tab. Browse and double click a specific preset animation to apply.
  • Tip: To reset the settings, click the Reset button.

• **To change text position in the Preview Window**
  • In the Preview Window, a red frame appears around the text. You can click and drag it to the position you want.

• **To adjust the duration of text clips**
  • On the Timeline, drag the edges of the clip.
• **Add Intro/Credit**

The Intro/Credit can be added in any position on Timeline to create chapters, intro, credit and casts for your video. You can go to the Intro/Credit Library to choose and apply the effect. Actually, Intro/Credit is a combination of a photo and a text clip, you can double click on them to edit just like editing photos and texts.
10. Apply Special Effects

Effects change the look or tone of your footage. You can apply to clips in order to change their style or appearance. Using special effects is a creative way to enhance your clips.

• **Apply effects**

Effects can be applied to photo or video clips in the Video Track. To add filters, follow the steps below:

1. Click the Effect button to display the thumbnails of various filter samples. You can choose to browse all the filters or just a specific category.
2. Choose filter from thumbnails shown in the Library. Drag and drop it to the Timeline or right click it and select “Apply”. Then an icon indicating the filter will be added to the Effect Track of the timeline. In the Preview Window, you can preview the effect timely.

Tip: You can add filters to different parts of the video. Drag the Slider out of the current part, and select another filter from the Library. Then the new filter will be added.
• **Customize effects**
  • Wondershare Video Editor allows you to customize effects in different ways, such as by changing the duration or parameters.
  • **To change the duration**
    • The default length is 5 seconds. But you can drag the edge of the icon to change the duration.
  • **To change the parameters**
    • Double click the filter to customize the parameters. Then you can view how your clip looks with the filter applied to it in the Preview Window.
  • Note: Available parameter options depend on the selected filter. Some of the filters don’t have this option.
• **Save and delete effects**

• **To customize text**
  
  You can choose and save your favorite effect to the Favorite Folder for easier access next time. You can also delete the filters from the project.

• **To save an effect in “Favorite” Folder**
  
  Right click one filter effect from the list and select “Add to Favorite”. The filter effect will be stamped a heart icon. Then you can go to the Favorite category to check your favorite filter effects.

• **To delete an effect from a project**
  
  Right click the filter and choose “Delete” to remove it from the project.
11. Add Overlay clips (PIP)

Adding multiple overlay clips gives you more creative possibilities for your movie. This feature is called PIP (Picture-in-picture) in Wondershare Video Editor. You can superimpose clips over background clips or add objects and frames to your video.

• **Add clips to PIP tracks**

Wondershare Video Editor enables you to add up to 10 PIP tracks. You can either add your own clips or choose from our PIP resource.

• **To add clips to PIP tracks**

1. In the Media Library, select the overlay clip that you want to add to your project.
2. Drag the media file from the Media Library to the PIP Track on the Timeline.

• **To add PIP resource**

The program also provides various PIP objects and frames. You can browse all the PIP resources or choose a specific category.
To add the PIP resource, drag one PIP element to the Timeline from the collections or right click the element and choose “Apply”. You can also right click and choose “Add to Favorites” to add the elements to the favorite folder.

• **Adjust overlay clips**

After the over overlay clips are added, you can easily adjust them.

• **To reposition an overlay clip**

Drag the overlay clip to the desired area on the Preview Window. It is recommended that you keep the overlay clip away from the texts.

• **To resize an overlay clip**

In the Preview Window, drag the handles around the overlay clip to resize it. Note: If you drag the white corner handle, it will keep the aspect ratio when you resize the clip.
• **Apply motion to an overlay clip**

Double click the target overlay clip. Then preview and select a direction mode from the Library. Then double click the motion to apply. If you want to remove the motion, right click the overlay video on the track and choose “Delete Motion”.

![Motion options](image)
• **Add a mask frame**

Adding a mask to an overlay clip applies a shape around it that you can render opaque or transparent. To do this, click the Advanced button and choose the “Mask” option. Then you can browse the mask frame and double click it to apply.
After a mask frame is added, you can move the sliders below to adjust the settings and watch the Preview Window to see how the new settings affect the overlay clip.
• Chroma key an overlay clip

Chroma key makes a particular color in a clip transparent and shows the clip in the Video Track as background. To add this effect, follow the steps below:

1. Double click the overlay clip. In the pop-up windows, click “Advance” > “Effect” to access the Chroma key tool.

2. Tick “Make parts of the clip transparent” and use the picker tool to choose the color to be rendered as transparent in the Preview Window.

3. In the Intensity Level option, move the slider to adjust the range color to be rendered transparent.
Click the color you want to make transparent, then drag or adjust the intensity level. As you drag, the selection grows to include areas that use the similar colors.
• **Other options**

  • Besides the Chroma Key effect, you can also add a shadow or border and flip or rotate the overlay clip.

  • **To add a shadow to an overlay clip**
    • In the Effect tab, click shadow options. Then tick Apply shadow to the clip and then adjust the settings below as per your needs.

  • **To add a border to an overlay clip**
    • In the Effect tab, click border options. Then tick Apply border to the clip and then adjust the settings below as per your needs.

  • **To flip or rotate an overlay clip**
    • In the Effect tab, click Flip options. Then click the four buttons to flip or rotate your clip.
With your project finished, it’s time to save and share it. When you save the project, all the files are combined to create a single video file. You can save the movie as a video file to be played on a computer or a mobile device, burn your project to a disc, or upload it directly to a YouTube, Facebook or Vimeo account.

- **Choose a sharing option**

After you finish the project, hit Export and choose from the following sharing options:

A. **Device**: Save to a file format that lets you play your movie on mobile devices, game consoles, or video players.

B. **Format**: Save to a file format that lets you play your movie on computers.

C. **YouTube/Facebook/Vimeo**: Share your work on YouTube, Facebook or Vimeo from within the program.

D. **DVD**: Burn your movie to a disc or save as ISO image file.
• **Save to video files for mobile devices**

  • Go to the “Device” tab. In the Device drop-list, choose an option such as iPhone, iPad, iPod, PSP, Wii, Creative, etc. to get the optimized videos for your devices. In the Name box, type a file name. In the Save to box, specify the location where you want to save the file.

  • If you want to adjust the default settings, click the little triangle button behind Advanced settings. Then you can change settings such as encoder, frame rate, bit rate and more.

  • If everything is OK, click “Export”.
• **Save to video files for computer playback**

  • Go to the “Format” tab. In the Profile drop list, choose an option such as AVI, WMV, MOV, FLV, MP4, MKV, etc. In the Name box, type a file name. In the Save to box, specify the location where you want to save the file.

  • If you want to adjust the default settings, click the little triangle button behind Advanced settings. Then you can change settings such as encoder, frame rate, bit rate and more.

  • If everything is OK, click “Export”.
• **Upload to YouTube/Facebook/Vimeo**

  • Go to the “YouTube”, “Facebook” or “Vimeo” tab. Then click the Sign in button to sign in. If it is the first time you are signing in, you will be asked to authorize the connection between Wondershare Video Editor and your online account. This authorization allows for the exchange of limited information related to the successful upload of your video. If you don’t have an existing account, you will be prompted to create an account.

  • Fill in the necessary information like title, description, quality privacy settings and additional tags.

  • If everything is OK, click “Export”.

  • Tip: To log in to a different user account, first click the Sign Out button that appears below the YouTube, Facebook and Vimeo images. You can then log in to a different user account.
• **Burn to DVD**
  
  • Go to the “DVD” tab. Then set the DVD parameters like DVD label, Aspect Ratio, TV Standard and Video Quality, DVD Disk Type and the Output settings such as DVD Folder and Output Type. After that, click Export to burn your video to DVD or save video to an ISO image file.
13. More

- Go to our YouTube Video Channel to get more video tutorials:
  - https://www.youtube.com/user/Wondershare
  - Or
  - https://www.youtube.com/channel/UC8567DmojT8Ca3oZQlKip9w

Thank You!